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In this chapter, you’ll learn how to use the Edit pages to modify existing timelines and to assemble 
new timelines from scratch. Whether you’re replacing VFX clips prior to grading, fixing problems 
with an errant conform, making last-minute re-edits to a program during finishing, or creating a 
rough assembly of a set of dailies to hand off to an editor, the Edit page has many of the tools you’re 
accustomed to using in other editorial environments, and a few that are unique to DaVinci Resolve. 
This chapter covers the following topics:

Edit

Understanding the Edit Page Interface 170

Timelines 170

The Media Pool 173

Effects Pool 174

Edit Index List 175

Source/Offline and Timeline Viewers 176

Inspector 178

Timeline 178

Toolbar 182

Customizing the Edit page 183

Undo and Redo in the Edit Page 184

Creating and Duplicating Timelines 185

Basic Editing 186

Selecting Clips to Edit 186

Playing Clips and Transport Controls 188

Setting In and Out Points 190

Creating, Deleting, and Moving Timeline Tracks 191

Using Snapping and Zooming 191

Drag and Drop Editing 192

Appending Clips to the End of the Timeline 193

Setting Destination Controls to Choose a Track to Edit Onto 194

Source/Record Editing 194

Setting In and Out Points in the Timeline 195

Assembling a Simple Sequence of Clips Using Overwrite Edits 198

Three-Point Editing 199



EDIT4

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

168

Types of Edits 205

Overwrite Edits 205

Insert Edits 206

Replace Edits 207

Fit to Fill 209

Place On Top 211

Append at End 212

Match Frame Operations 213

Matching From the Timeline 213

Matching From a Source Clip 214

Working in the Timeline and Altering Edits 215

Selecting Clips in the Timeline 215

Using the Timeline Auto Select Controls to Define Selections 216

Deleting Clips From the Timeline 218

Selecting and Deleting Gaps in the Timeline 220

Selecting Edits in the Timeline 221

Linking and Unlinking Audio and Video 222

Dealing with Audio Video Sync Offsets 224

Locking Tracks 224

Moving and Trimming Clips in Normal Edit Mode 225

Splitting and Joining Clips 227

Copying and Pasting Clips in the Timeline 228

Duplicating Clips in the Timeline 228

Flagging and Marking Clips for Reference 228

Marking the Timeline 229

Using Trim Mode and the Trim Tool 230

Enabling and Disabling Clips and Tracks 235

Using a Take Selector 236

Finding Media 238

Working With Transitions 239

Compound Clips 241

Adding Titles and Generators 243
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Applying Effects in the Edit Page 245

Using Stills 245

Composite Modes and Transparency Effects 245

Opacity 249

Alpha Channel Support 249

Keying, External Mattes, and Window Compositing 249

Transform and Cropping 250

Speed Effects 253

Clip Retiming Effects 254

Keyframing Effects in the Edit Page 259

Chapters 5 and 6 covers how to use the Edit page to import and conform projects edited in other 
applications for color correction and finishing in DaVinci Resolve.
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In many ways, the Edit page has evolved to resemble a cross between the traditional highly-
organized DaVinci Resolve interface, and a source-record style NLE. The Edit page is divided into 
three main regions: the browsers found at the left, the Viewers at the top right, and the Timeline at 
the bottom right, all of which work together to let you import, edit, and assemble timelines.

Timelines

DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in 
other applications) which are organized in the Timeline list at the left, and displayed in the Timeline 
editor (referred to as “the Timeline”). Timelines contain clips, the source of which is kept in the 
Media Pool, and which also appear as edit events in the Edit Index that can be shown under the 
Timeline list.

Timelines and Grades

Within any given timeline, grades are associated with the timecode of the source clip they’re applied 
to. By default, different timelines have independent sets of grades using Local versions. That means 
each clip within every timeline has a completely independent grade.

However, if you switch one or more timelines to use Remote grades, a clip’s grades are shared 
by every instance of that clip in all timelines using Remote versions. If you import a new timeline 
that rearranges clips into a different order and switch it to using Remote versions, then grades will 
automatically follow the clips, so that the clips within each new timeline inherits the grades applied 
to those same clips in other timelines.

Understanding the Edit Page Interface

The Edit Page in its entirety
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You can switch a timeline between using Local and Remote grades at any time. For more information 
on using Local versus Remote versions, see Chapter 8, “Color.” You can also copy grades from 
one timeline to another using the ColorTrace feature. For more information about ColorTrace, see 
Chapter 6, “Conforming Projects.”

The Timeline List

The Timeline list contains all timelines that have been either imported or created within that project.

Every AAF, XML, or EDL file you import appears as a new timeline in this list, or you can create new 
timelines of your own in order to assemble different sequences of clips. You can have as many timelines 
as you need within a single project. Since each timeline references clips in that project’s Media Pool, 
multiple timelines are most often used for multiple edited versions of a particular program or reel. 
Additionally, multiple timelines can be used to create differently graded versions of a particular edit.

To switch timelines, do one of the following:

 > In the Edit page, click a timeline in the Timeline list, or choose a timeline from the Timeline 
Viewer name pop-up menu.

 > In the Color page, choose a timeline from the Timelines pop-up menu at the top of the viewer.

To switch timelines using the DaVinci control surface:

1. Press MODES, above the fourth trackball on the Center panel.

2. Press the SWITCH SESSION soft key repeatedly to switch among all available timelines in the 
Project Browser.

3. Press MODES again when you’re finished.

The Timeline list
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Creating a Master Timeline

Previous versions of Resolve had a Master Timeline, which consisted of one long sequence of 
every clip in the Media Pool, arranged in ascending order by timecode. While the Master Timeline 
was useful for a variety of tasks, architectural improvements have rendered it unnecessary, and by 
default it does not appear in new projects created by DaVinci Resolve version 10.

However, if you want a Master Timeline in order to have a single timeline that always contains all 
clips currently in the Media Pool, there’s a way you can create one. You need to do it immediately 
upon creating a new project, before adding any media to the Media Pool. Once you’ve added one 
or more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1.  Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox. If you also want all clips to 
use Remote versions as you grade by default as in previous versions of Resolve, you can turn 
off the “Store grade with local version by default.”

2.  Click Apply, and close the Project Settings window.

3.  Open the Edit page, and choose File > New Timeline.

4.  When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, 
and click Create New Timeline.

 Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.

Turning on the option to use a Master Timeline
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The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in 
ascending order by timecode. Each clip in the Master Timeline appears at its full duration, regardless 
of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. Whenever you 
add more clips to the Media Pool, they’re automatically added to the Master Timeline. 

The Master Timeline is useful for organizing media for which no editing has yet been done, such 
as when grading digital dailies. The Master Timeline is also useful for identifying a range of similar 
clips, based on their similar ranges of timecode. For example, you could find all the talking head 
shots from a particular section of tape clustered together in the Master Timeline.

The Media Pool

The Media Pool is also displayed on the Edit page, showing you all of the source clips that are 
available for editing. By default, the Media Pool has a single bin, named “Master.”

If you create multiple bins in the Media Pool, they appear as additional headers underneath the 
Master bin. Each header has a disclosure triangle at its left that lets you show and hide the contents 
of that bin. You can create more bins by right-clicking anywhere in the empty area of the Media Pool 
and choosing Add Bin. You can rename any custom bin by double-clicking on its name and typing 
a new one, or by right-clicking a bin header and choosing Rename Bin.

The Media Pool in Thumbnail mode

Creating a Master Timeline
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Effects Pool

The Effects Pool contains a bin with the different Video Transitions, Title Effects, Generators, and 
Filters that are available for editing in the Timeline.

You can drag any video transition to any edit point in the Timeline that has overlapping clip handles 
to add it to your edit; you have the option to drag the transition so that it ends on, is centered on, 
or starts on the edit point simply by dragging it to the appropriate location.

Titles and Generators can be edited into the Timeline like any other clip. Once edited into the Timeline, 
you can open that clip into the viewer to access its controls in the Inspector, for customization.

Filters can be dragged and dropped onto any clip. Once applied, that clip can be opened into the 
Timeline to access generator controls in the Inspector.

The Effects Pool, made taller to show all of its contents
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Edit Index List

Clicking the Edit Index button opens the Edit Index below the Timeline list. This shows an EDL-style 
list view of all the edit events in the current timeline. Whichever timeline is selected in the Timeline 
list displays its events here. 

Each clip and transition is shown as an individual event, each of which contains multiple columns of 
information. If you re-edit a timeline, your changes are also reflected in this list.

Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show only 
the clips on the video track the intersecting clip is on, and that clip’s event is highlighted in the Edit 
Index. This makes it easy to see the correspondence between a clip in the Timeline and its event, 
which is helpful when troubleshooting problems. There are also commands available in the Option 
menu to display only clips on enabled tracks, only video clips, and only audio clips.

Each event populates several columns of information. These columns can be rearranged depending 
on what information is most important to you. The available columns of information are:

 > #: The event number (which corresponds to the clip number shown in the Thumbnail 
Timeline of the Color page)

 > Reel: The reel name of the corresponding clip

 > V: Video event

 > C: The event type (C for cut, D for dissolve or transition)

Edit Index List shown open
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 > Dur: A number showing the duration of a transition in frames. 

 > Source In/Source Out: The Source In and Source Out timecode indicating the originating 
timecode referenced by that clip

 > Record In/Record Out: Record In and Record Out timecode indicating that clip’s position 
in the Timeline.

 >Name: The name of the clip.

 > Comments: Whatever comments were present in the EDL that was imported. For example, 
clip names exported from the original NLE to be used as reel names in RED workflows 
using EDL import.

Source/Offline and Timeline Viewers

The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. 
Meanwhile, the Timeline Viewer shows the frame at the position of the playhead in the Timeline. 
You can select either viewer by clicking, and the name of the viewer that currently has focus 
appears in orange. 

Note: The Color Viewer Lookup Table options in the Look Up Tables of the Project Settings only 
affect the GUI Viewer in the Color page. They do not affect the viewers in the Edit page.

Both viewers share the following onscreen controls:

 > Zoom pop-up menu: Choosing Fit fits the currently visible frame to the available size of the 
viewer. Choosing a percentage zooms the visible frame to that size.

 > Duration field: At the top left-hand side of the Source Viewer, this displays the total duration 
of the clip, or the duration from the In to the Out point, if these have been placed. In the 
Timeline tab, this displays the total duration of the currently selected timeline.

Source and Timeline viewers
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 >Clip Name: The clip name is displayed at the center of the Source Viewer title bar. The 
Timeline Viewer displays the timeline name and is also a pop-up menu that lets you switch 
among other timelines in the current project. The clip/timeline name is highlighted orange 
when either the Source or Timeline Viewer has focus.

 > Source/Timeline Timecode Display: At the top right-hand side of the Source Viewer, this 
field shows the timecode of the current frame at the position of the playhead in the Source 
Viewer’s jog bar. In the Timeline tab, this field shows the timecode of the current frame at 
the position of the playhead in the Timeline. 

 >Option menu: The option menu contains the Loop command to loop playback in that viewer.

 > Jog bar: In the Source Viewer, drag within the jog bar to reposition the Source playhead, 
scrubbing through the clip. In the Timeline tab, drag to reposition the playhead throughout 
the entire program.

 >Offline Mode button (Source Viewer only): If you’ve assigned an offline movie to the 
currently selected timeline, clicking the Offline Mode button lets you display the offline 
movie so you can compare it with the currently open timeline. In this mode, Source and 
Timeline playback are synched; an Offset field is available to resync the offline movie, if 
necessary. More information on how to use the Offline Viewer appears later in this chapter.

 > Video button (Source Viewer only): Shows the video of the currently open clip in the Source 
Viewer.

 > Transport controls: These controls include, from left to right, Jump to First Frame, Play 
Forward/Stop, Jump to Last Frame.

 >Match Frame: In the Source Viewer, Match Frame attempts to move the playhead in the 
Timeline to match the current frame of the clip in the Source Viewer. In the Record Viewer, 
Match Frame opens the Media Pool clip corresponding to the clip at the current position of 
the playhead into the Source Viewer, setting In and Out points and the playhead position 
to match those of the clip in the Timeline.

 > In/Out buttons: Places In and Out points with which to define a range of the clip, or of the 
Timeline, in preparation for making different kinds of edits.

When you turn on Offline Mode in the Source Viewer, one additional control appears that replaces 
the Duration field:

 >Offset field: Lets you specify an offset, in frames, with which to sync an offline-identified 
media clip that you’ve imported to compare to the currently selected timeline. You can 
select the number in this field in order to type a new value, or you can use the Up/Down 
arrow buttons to alter this value.
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Inspector

The Inspector can be opened to let you customize compositing, transform, cropping, retiming, and 
time mapping for any clip. Furthermore, the Inspector lets you edit the parameters of transitions, 
titles, generators, and filters used in the Timeline, in order to customize their effect.

When the Inspector is open, the Edit page switches to a single-viewer mode, showing you the 
Timeline item that you’re inspecting.

Timeline

The Timeline shows whichever item is currently selected in the Timeline list. It provides a visual 
representation of the edited program that’s helpful for verifying that the project was imported 
correctly, checking the media corresponding to each clip in the program, and performing simple 
editorial tasks necessary to prepare a project for grading (such as replacing or adding clips, 
superimposing composites, and modifying composite modes or transitions).

The Inspector, opened and showing a clip’s parameters

An edited timeline
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 > Timeline Ruler: The Timeline Ruler shows the program’s timecode, and the playhead 
indicates the current frame of the current clip. Whichever clip intersects the playhead is the 
one that you’ll be working on in the Color page. Dragging within the Timeline Ruler moves 
the playhead.

 > Playhead: The playhead automatically syncs with the Timeline Viewer’s jog bar playhead, 
the playheads in the Mini-Timeline and Thumbnail Timeline of the Color page, and the 
playhead on the Deliver page. Furthermore, the Edit Index list event that corresponds to 
the clip intersecting the playhead is automatically highlighted.

 > Timecode field: Shows the current timecode value corresponding to the position of the 
playhead.

 > Video Tracks: DaVinci Resolve supports multiple video tracks. At the left of each track is a 
header area that contains a number of controls.

 > Track Header: The Track Header contains different controls for selecting, locking/unlocking, 
and enabling/disabling tracks. Each track header also lists how many clips appear on that 
track. The Track Header contains the following five controls, from left to right:

Track Header showing the Lock Track and Enable Track buttons enabled
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 > Lock Track button: Light gray when turned on, dark gray when turned off. When a track is 
locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked tracks 
can be graded. When turned off, all editorial functions are enabled.

 > Auto Selection button: On by default. Light gray when that track is selected, dark gray 
when that track is not selected. Turning this control on enables clips on that track to be 
included in compatible operations that depend on the position of the playhead, or on 
Timeline In and Out points.

 > Destination control: Light gray with the text of the source track that’s being assigned when 
that track is selected, dark gray when that track is not selected. The Destination buttons 
dictate into which tracks audio and video media in the Source Viewer will be placed when 
an edit is executed. Ordinarily, there is one video destination control (V1) and one audio 
destination control (A1).

 > Track Number: Each track is numbered according to its position. The bottom track is “Video 
1,” and subsequently numbered tracks appear higher in the Timeline. Click any track’s number 
to select that track for different editing functions; the selected track is highlighted black.

 > Enable Track button: A slash indicates when a track is disabled. This control lets you turn 
tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, don’t show 
up in the Color page, and aren’t available for rendering or output.

 > Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of video tracks is taller than the current height of the Timeline, 
these scroll bars let you navigate around your program. 

 > Zoom slider: Lets you zoom into or out of the clips in the Timeline. Use the scroll wheel of 
your mouse to horizontally zoom into and out of the Timeline. Scrolling up zooms in, while 
scrolling down zooms out. You can also use Command-Plus to zoom in, and Command-
Minus to zoom out, and Shift-Z to fit every clip in your program into the available width of 
the Timeline.

 > Expand Timeline button: Click to expand the Timeline to the full width of your display.

Expanding the Timeline to fill the full width of the screen, button circled in red
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This pushes the Project, Media Pool, and Effects Pool lists up so they’re shorter. Click again to shrink 
the Timeline back to the width of the Source and Timeline Viewers.

 > Customize Timeline pop-up menu: Four sets of controls let you customize the look of the 
clips on the tracks (filmstrip, thumbnail, or minimized), whether or not to display audio 
waveforms, whether or not to display flags and markers, and the independently adjustable 
height of the video and audio tracks.

Expanding the Timeline to fill the full width of the screen, button circled in red

Selecting the Timeline Viewing options
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 > Show Edit Index button: Opens and closes the Edit Index list, which shows a text list of all 
edits in the Timeline, with columns for edit number, reel, cut type, duration, source and 
record in and out points, clip name, and comments. These columns can be rearranged, 
depending on what information is most important to you. There are also commands 
available in the Option menu to display only clips on enabled tracks, only video clips, and 
only audio clips.

 > Show Audio Meters button: Opens and closes the Edit page audio meters, which also 
contain the audio mute button. If you have a display with 2560x1440 resolution you can see 
all 16 audio meters, but on lower resolution displays only 8 audio meters appear. 

Toolbar

Eleven buttons starting from the left, running along the top of the Timeline, let you choose different 
tools for performing various editing functions. 

 >Normal Edit Mode: The default mode in which you can move and resize clips in the Timeline, 
roll edits, and do other basic editing tasks.

 > Trim Edit Mode: In this mode, the Trim tool lets you make slip, slide, ripple and roll edits by 
dragging different parts of clips in the Timeline, or by making specific selections and using 
the “nudge” keyboard shortcuts of comma and period to move the selection left or right.

 > Razor Edit Mode: Lets you add cuts to the Timeline by clicking.

 >Overwrite Edit: Performs an overwrite edit to the Timeline with whatever clip is in the 
Source Viewer.

 > Insert Edit: Performs an insert edit to the Timeline with whatever clip is in the Source Viewer.

 > Replace Edit: Performs a replace edit to the Timeline with whatever clip is in the Source Viewer.

 > Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.

 > Link Audio/Video: Enables or disables Audio/Video linking. When turned on, clicking a 
video clip in the Timeline automatically selects the corresponding audio clip if they’re 
linked together. When turned off, clicking a video clip won’t select its audio. Clip linking 
can be toggled while you work by pressing the Option key while clicking to make selections 
in the Timeline.

Buttons in the Toolbar
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 > Flag Clip/Flags pop-up menu: Flags identify clips, and indicate all clips that correspond to 
the same item of media in the Media Pool. Clips can have multiple flags. Clicking the Flag 
button automatically adds a flag to whichever clip is currently selected in the Timeline. A 
pop-up menu to the right lets you choose differently colored flags, and clear all flags from 
the currently selected clip.

 > Add Marker/Marker pop-up menu: Markers identify specific frames of individual clips. 
Clicking the Add Marker button adds a marker of the currently displayed color to the clip 
at the position of the playhead in the Timeline. A pop-up menu to the right lets you choose 
differently colored markers, and clear all markers from the currently selected clip.

These functions are described in greater detail in the following sections of this chapter.

Customizing the Edit page

The default layout is quite efficient for a number of tasks on most displays. You can always return to 
the default layout by choosing View > Reset UI Layout.

However, the Edit page can be customized to create more room for specific areas of the interface 
to accommodate different tasks.

To resize any area of the Edit page:

 > Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

To expand the width of the Timeline:

 > Click the Expand button underneath the Timeline, to the left. The Timeline expands to the 
left, and the Effects Pool (or EDL list) is pushed up to share space with the Media Pool and 
Timeline list, which sit to the right of the Source and Timeline Viewers. Click the Expand 
button again to return the Timeline to its original width.

To open and close the Edit Index and Effects Pool:

 > Click the Edit Index button in the group at the bottom left of the Edit page.

To customize the Edit Index list:

 > To resize any column of the Edit Index: Move your pointer over the divider between any two 
columns and drag when the horizontal resize cursor appears.

 > To sort the Edit list by any column: Click the Option button at the top right to display all 
active tracks, just the video, or just the audio tracks.

To show and hide the Audio Meters:

 > Click the Audio Meter button in the group at the bottom right of the Timeline.
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Undo and Redo in the Edit Page

The Edit page has its own multiple-undo stack, which is separate from the multiple-undo stacks of 
each clip in the Color page. The Edit page undo commands have been separated to make it easy 
and reliable to undo edits and other changes you make in the timeline without disturbing your work 
in the Color page. 

To undo and redo:

 > Press Command-Z to Undo, and Shift-Command-Z to Redo.

Note: Each timeline has its own undo stack.
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If you’re not importing a project that’s been edited elsewhere, you can create a new timeline for 
purposes of grading a set of dailies, creating a rough assembly for a best-light, or cutting together 
a simple edit for any reason. When you create a new timeline, you can either create a timeline that 
contains all clips found in the Media Pool to quickly create a big batch of offline dailies, or an empty 
timeline that’s ready for you to add specific clips to.

For example, you could create an empty timeline, sort the Media Pool by reel name, and add all 
clips from a particular reel to a dedicated timeline. Alternately, you could use a blank timeline to 
create a simple manual rough edit of your own sequence of clips while comparing clips to one 
another on set.

To create a blank timeline:

1. Do one of the following:

 > Select the + icon at the bottom of the Timeline list. 

 > Choose File > New Timeline.

 > Right-click within the Timeline list of the Edit page, and choose Create New Timeline.

2. When the New Timeline Options window opens, set the following options:

 > Start Timecode: You can change the Start Timecode if a specific start time is required.

 > Timeline Name: Enter a name into the Timeline Name field.

 > Empty Timeline: By default a new timeline will be empty. If you turn off the Empty Timeline 
checkbox, the new timeline that’s created will contain all the media found within the 
Media Pool.

3. Click OK.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter an 
edit or create an alternate grade. 

To duplicate a timeline:

Right-click the sequence you want to duplicate in the Timeline list and choose Duplicate Timeline 
from the contextual menu. A new timeline will appear in the list with “copy” appended to the name.

Creating and Duplicating Timelines
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DaVinci Resolve has a suite of editing tools that make it convenient to perform common online 
editorial and timeline management operations. There are also effects functions available for making 
alterations to clip speed, opacity, and composite modes for superimposed clips.

Selecting Clips to Edit

The following procedures show how to select one or more clips in DaVinci Resolve to accomplish 
various editing tasks, either by opening a clip in the Source Viewer, or selecting a group of clips with 
which you want to do drag and drop editing.

First, you need to browse the contents of the Media Pool to find clips you want to use. Then you can 
make a selection in preparation for your next operation.

Methods of browsing clips in the Media Pool:

 > Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer over a 
thumbnail to play though its contents.

 > Using the Media Pool Filmstrip in the Media Pool’s List view: Select a clip to expose it in the 
Filmstrip at the top of the Media Pool, and drag the pointer through the Filmstrip to watch 
it play.

Thumbnail hover scrubbing

Using the Filmstrip when the Media Pool is in List view

Basic Editing
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Methods of selecting clips in the Media Pool:

 > To select a single clip using the mouse: Click a clip in the Media Pool with the mouse. 

 > To select a single clip using the keyboard: Use the Arrow keys to change the selection from 
clip to clip in the Media Pool, up, down, left, and right. If you’ve selected a bin, use the left 
arrow key to close the bin, and the right arrow key to open the bin. Once a clip is selected, 
you can press an edit keyboard shortcut to edit the selected Media Pool clip straight to the 
currently open timeline.

 > To select a contiguous range of clips: In Icon mode, drag a selection box over all the clips 
you want to select. In Icon or List mode, select the first clip in a series, then Shift-click the 
last clip to select those clips and everything in between.

 > To select a noncontiguous range of clips: Command-click each clip you want to include in 
the selection.

 > To select all clips in the Media Pool: Make sure the Media Pool has focus, then press 
Command-A to select all clips.

Once you’ve opened a clip into the Source Viewer, you can use the transport controls to play 
through it.

Selecting a contiguous range of clips

Selecting a discontiguous range of clips
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Playing Clips and Transport Controls

Once you’ve decided which clips you want to use in your program, you can open them into the 
Source Viewer to review them more completely.

Opening a clip into the Source Viewer:

 > Using the mouse: Double-click any clip in the Media Pool to open it into the Source Viewer.

 > Using the keyboard: Use the Arrow keys to change the selection from clip to clip in the 
Media Pool, up, down, left, and right. If you’ve selected a bin, use the left arrow key to close 
the bin, and the right arrow key to open the bin. Press Return to open the selected clip into 
the Source Viewer.

Monitoring With An External Video Display

While working in the Edit page, the image that’s displayed on an external video display (if one is 
connected) is determined either by the current selection in the Media Pool, or by which part of the 
Edit page interface has focus. For example, if you select a clip in the Media Pool so it’s displayed 
within the Filmstrip, that clip is output to video. If you then open it into the Source Viewer, then the 
contents of the Source Viewer are output to video. If you switch to the Timeline Viewer, then your 
timeline is output to video.

Transport Controls

The Edit page has two viewers. The left viewer, when you’re editing, should be set to show either 
source video or source audio, so it shows the source clip in any edit you’re setting up. At right is the 
Timeline Viewer, that shows the frame at the current position of the playhead in the Timeline. Using 
the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the viewers. A jog bar appears directly 
underneath the image, letting you drag the playhead directly with the pointer. The full width of the 
Source Viewer’s jog bar represents the full duration of a clip, while the full width of the Timeline 
Viewer’s jog bar represents the full duration of the current timeline. The current position of each 
playhead is shown in the timecode field at the upper right-hand corner of each viewer.

The transport controls at the bottom of the Source Viewer
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Transport controls appear underneath the jog bar, letting you Jump to First Frame, Play Forward/
Stop, and Jump to Last Frame. There are also a series of keyboard shortcuts you can use to 
control playback:

 > Spacebar: You can use the spacebar to start and stop playback.

 > JKL: DaVinci Resolve uses a simple version of the JKL keyboard shortcut convention for 
controlling playback, where J plays in reverse, K stops playback, and L plays forward.

 > Fast Forward/Fast Reverse: Shift-J plays in fast reverse, Shift-L plays in fast forward.

 > Step Forward/Step Back: The Left Arrow and Right Arrow keys move back and forth one 
frame at a time, while Shift-Left Arrow and Shift-Right Arrow move the playhead in one 
second increments.

 >Next Edit/Previous Edit: Up Arrow moves the playhead to the previous edit and selects the 
edit point, while Down Arrow moves the playhead to the next edit and selects the edit point.

 > First and Last Frame of the Current Clip: The Semi-colon key moves the playhead to the first 
frame of the clip intersecting the playhead, while the Apostrophe key moves the playhead 
to the last frame of the clip intersecting the playhead.

 > Previous Keyframe/Next Keyframe: Shift-Semi-colon moves the playhead to the previous 
keyframe on the left when keyframes are displayed in the Timeline, while Shift-Apostrophe 
moves the playhead to the next keyframe to the right.

 > Timeline Start/Timeline End: The Home key moves the playhead to the first frame of the 
Timeline, while the End key moves the playhead to the last frame of the Timeline.

 > In Point/Out Point: Shift-I moves the playhead to the In point set in either the viewer or the 
Timeline. Shift-O moves the playhead to the Out point.

Tip: One of the General Options in the Project Settings window, “Always highlight current clip in 
the media pool,” lets you decide whether the current selection in the Timeline is mirrored in the 
Media Pool.

Additional Playback Controls

In addition to the standard transport controls, there are some additional playback controls, available 
via keyboard shortcuts or the Playback menu, that let you perform different playback operations.

 > Play around current frame: Forward Slash (/). Plays a section of the Timeline from x frames 
before to x frames after the current position of the playhead. This command is useful for 
previewing how edits play within the context of the clips immediately surrounding them. 
The pre and post roll duration of this preview can be customized in Project setting, editing.

 > Play around current clip: Plays a section of the timeline from x frames before to x frames 
after the current clip intersecting the position of the playhead.

 > Loop: Command-Forward Slash. Toggles looped playback off and on.
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Setting In and Out Points

Now that you’ve reviewed your clips, you can place In and Out points to set the range of each clip 
that you want to edit into the Timeline. If you don’t set In or Out points, then the entire clip will be 
edited into the Timeline.

To set In and Out points in different areas of the Edit page:

 > Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to List 
view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the 
pointer through the Filmstrip to watch it play and press I and O to set In and Out points to 
the appropriate range. The Filmstrip will dim the heads and tails to let you see the range of 
media you’ve marked. Once you’ve marked In and Out points in the Filmstrip, you can drag 
them to the left and right to move them.

 > Using the Source Viewer: Open a clip in the viewer by double-clicking it in the Media Pool, or 
selecting it in the Media Pool and pressing the Return key. Then use the transport controls, 
jog bar, or control surface buttons to move the playhead, and place In and Out points using 
the In and Out buttons to the right of the transport controls, or by pressing the I or O keys.

Marking In and Out points in the Filmstrip of the Media Pool in List view

Marking In and Out points in the Source Viewer
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Other methods of working with In and Out points in the Source Viewer:

 > To clear In or Out points: With the Source Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

 > To clear both the In and Out points at once: With the Source Viewer selected, press Option-X.

 > To jump the playhead to the current In or Out points: With the Source Viewer selected, 
press Shift-I to immediately move the playhead to the current In point, or Shift-O to move 
the playhead to the current Out point.

Once set, In and Out points remain in place within each source clip until you set new ones.

Creating, Deleting, and Moving Timeline Tracks

When you’re getting ready to edit clips into the Timeline, it’s a good idea to make sure you’ve got 
enough tracks to do the job. The following procedures cover the different methods available for 
adding, removing, and rearranging tracks as you work.

Methods for adding, deleting, and rearranging tracks:

 > To add a track to the Timeline: Right-click on the left of the Timeline and choose Add Track. 

 > To delete a track from the Timeline: Right-click on the left of the track and choose Remove  
Track. If there are clips on a track you remove, they are deleted from the Timeline.

 > To move tracks and the clips on them up and down: Right-click on the left of the track and 
choose Move Track Up or Move Track Down from the contextual menu. That track, along 
with all clips on it, will be moved up or down relative to the other tracks in the Timeline.

Using Snapping and Zooming

When preparing to make an edit into the Timeline, you can set the snapping and zoom controls to 
whichever state is most useful for the operation you need to perform. For example, if you’re editing 
an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in to better see 
the exact place where you want to place the incoming clip. Since there are many edits at that point, 
disabling snapping might make it useful to avoid having the clip jump to the nearest edit point if you 
need to move the incoming clip to a very specific frame.

Playhead Snapping and Timeline Zoom:

 > To turn clip and playhead snapping on and off: Click the Snapping button in the toolbar. 
When snapping is turned on, the In and Out points and markers of clips all snap to one 
another and to the playhead.
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 > To zoom into and out of the Timeline: Drag the zoom slider to the left to zoom out, and 
right to zoom in. You can also press Command-Plus and Command-Minus. Zooming is 
always centered on the current position of the playhead.

 > To frame every clip into the width of the Timeline: Press Shift-Z.

Drag and Drop Editing

The simplest method of editing is to drag clips from the Media Pool and drop them into the Timeline. 
You can do this with individual clips, or with selected groups of clips.

1. If you need to edit more specific ranges of the clips you’re editing, you can set In and Out 
points in source clips first by doing one of the following:

 > Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to List 
view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the 
pointer through the Filmstrip to watch it play and press I and O to set In and Out points to 
the appropriate range. The Filmstrip will dim the heads and tails to let you see the range of 
media you’ve marked.

 > Using the Source Viewer: Open a clip in the viewer by double-clicking it in the Media Pool, or 
selecting it in the Media Pool and pressing the Return key. Then use the transport controls, 
jog bar, or control surface buttons to move the playhead, and place In and Out points using 
the In and Out buttons to the right of the transport controls, or by pressing the I or O keys.

2.  If you want to edit several clips at once, select them in the Media Pool after you’ve finished 
setting In and Out points.

3. Drag the clip in the viewer, or the selected clips to the desired position in the Timeline to 
perform an overwrite edit, which replaces whatever was there before.

The snapping button in the toolbar
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Appending Clips to the End of the Timeline

If you simply need to add one or more clips to the end of the currently open timeline, you can also 
use the Append Edit command, available from the Media Pool contextual menu.

To append one or more clips to the end of a track:

1. Click the header of the track you want to insert the clip onto. If necessary, create a new track if 
you want to superimpose the clip you’re appending.

2. Select one or more clips in the Media Pool, or open a clip into the Source Viewer.

3. To perform the edit, do one of the following:

 > Choose Edit > Append at End

 > Press Shift-F12

 > Right-click one or more selected clips in the Media Pool, and choose “Append Selected 
Clips to Timeline.”

 The selected clips are appended, as the very last clip, to the selected track after the last clip 
on that track.

Dragging a clip into the Timeline
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A more controlled form of editing is to use three and four point editing to make a specific range of 
source media fit into a specific range of the Timeline. 

Setting Destination Controls to Choose a Track to Edit Onto

The destination controls, found in the Timeline header area, let you specify which video and audio 
tracks you want incoming source clips to be edited to when you use editing methods other then 
drag and drop. No matter how many video or audio channels may be embedded within a single 
clip of media, only one video and one audio destination control is available. In the case of video, 
you can only expose one video channel of a clip at a time. In the case of audio, all audio channels 
for a given clip are embedded within a single Timeline track, making it a snap to edit stereo or 
other multi-channel audio sources together. (For more information about working with audio, see 
Chapter 7, “Working with Audio.”)

Setting the destination control of a track is a vital step in the process of creating an edit, and is easy 
to do. You can set the video and audio destination controls to be separate tracks.

To set the destination tracks of incoming source clips, do one of the following:

 > Click the empty Destination Control area of any unassigned track in the Timeline.

 > Press Option-1 through 8 to set a video destination, or press Option-Command-1 through 
8 to set an audio destination.

Source/Record Editing

Selecting the Offline video to link to the current timeline
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Setting In and Out Points in the Timeline

When you’re setting up an edit to the Timeline, you can often get away with simply putting the 
Timeline playhead at the frame where you want to edit the incoming source clip. In the absence of 
In or Out points, the playhead is used as the In point. However, you can set up different kinds of 
edits by setting specific In and Out points to define different ranges of the Timeline.

Methods of setting and clearing In and Out points in the Timeline:

 > To set an In or Out point: Select the Timeline or Timeline Viewer by clicking or pressing 
the Q key, then use the transport controls, jog bar, or control surface buttons to move the 
playhead, and press the I key to set an In point, or the O key to set an Out point.

 > To clear In or Out points: With the Timeline Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

 > To clear both the In and Out points at once: Press Option-X.

 > To jump the playhead to the current In or Out points: Press Shift-I to immediately move the 
playhead to the current In point, or Shift-O to move the playhead to the current Out point.

Methods of moving In and Out points in the Timeline:

 > Press the I or O keys at any time to change the In or Out points.

 > Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is dimmed, 
to call attention to the portion of the Timeline that will be affected by the next edit you’ll make.

In and Out points shown in the Timeline, with unmarked areas outside the selection dimmed
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Mark Clip and Mark Current Selection

These commands are automatic ways of setting In and Out points in the Timeline both at once, using 
the timing of other clips. They’re both exceptionally handy for defining the range of an incoming 
edit using clips that are already in the timeline that you want to replace, or gaps in the timeline that 
you want to fill. 

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to automatically 
set Timeline In and Out points for editing. For example, if there’s a shot in an edit that you want to 
replace with a different take of the same action, or there’s a gap in a sequence of clips that you’d 
like to quickly fill with b-roll, you can use the Mark Clip command to help set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to automatically 
set Timeline In and Out points for editing. A good example is when you have a series of clips in the 
Timeline, all of which you’d like to overwrite with a single incoming source clip, you can use the Mark 
Current Selection command.

To use Mark Clip:

1. Move the playhead to intersect either a clip you want to use to set In and Out points, or a gap 
(empty area) between two other clips that you want to target. The playhead can be on any 
frame of this clip, it doesn’t matter which.

2. If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target to set the In and 
Out points. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

Positioning the playhead at a clip you want to mark
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3. Press the X key to automatically set In and Out points that match the first and last frames of the 
target clip.

 Tip: To clear both In and Out points, press Option-X, which is the opposite of this command.

To use Mark Selection:

1. Select one or more clips in the Timeline.

2. Press Shift-A to automatically set In and Out points that match the first and last frames  
of the selection. A range of discontinuous clips will produce the same result as a range of 
continuous clips.

Using Mark clip to set In and Out points that match a clip’s duration

Selecting clips you want to use as a range to mark In and Out points
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Assembling a Simple Sequence of Clips Using Overwrite Edits

Overwrite edits are by far the most common type of edit in most projects. They’re flexible in that 
you can eliminate unwanted material in other clips while at the same time adding new clips to the 
Timeline. The following example shows how you can use the Edit page to assemble a quick first cut 
of edits using different features of the Media Pool, Viewers, and Timeline.

1.  Open a clip into the Source Viewer, and set In and Out points to define the section of that clip 
you want to edit into your program.

2.  Click the destination control of the Timeline tracks you want to edit the incoming media onto. 
By default, the destination controls are assigned to tracks V1 and A1.

3.  Click the Overwrite Clip button in the toolbar (or press D) to edit that clip into the Timeline, 
with the source clip’s In point aligned to the position of the playhead in the Timeline. You 
can also drag a clip from the Source Viewer to the Timeline Viewer to use the edit overlays to 
perform different types of edits.

 Afterward, the playhead automatically moves to the frame immediately after the out point of 
the clip. If that clip is the last one on the Timeline, you’ll see the last frame to the left of the 
playhead instead of the black that is the actual frame after that clip to make it easier for you to 
line up the next edit. Otherwise, the playhead will show whatever frame happens to be at that 
point in time.

4.  Open the next clip you want to edit into the viewer, set In and Out points, and use the Overwrite 
Clip button or command to edit it into the Timeline. Continue this process until you’ve edited 
together the assembly of edits you want.

Marking a selection to set In and Out points
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Three-Point Editing

Three-point editing is a standard editorial method that’s shared with many other postproduction 
applications, so this procedure should feel familiar. The idea is that you need only set any 
combination of three In and Out points in the source clip and Timeline to edit a clip into your 
program at a specific time. Three-point editing is most commonly accomplished using Overwrite 
and Place-On-Top edits.

In the previous example of assembling a simple sequence of clips, three point editing was being used 
by virtue of source In and Out points being set to define a range of the source clip to be edited into the 
Timeline, and the Timeline playhead being used as the acting Timeline In point; three points defined the 
edit to be made. However, three point editing is also very useful when you need to overwrite sections 
of a previously edited timeline with new source clips in a controlled manner, such as when adding an 
insert shot to a scene to cover a particular change you’re making that would break continuity.

Depending on the combination of Source and Timeline In and Out points you set, the following 
rules govern three-point editing:

 > If there is no In point in the source clip: The first frame of media will be used as the acting 
source In point.

 > If there is no Out point in the source clip: The last frame of media will used as the acting 
source Out point.

 > If there are no In or Out points in the Timeline: The playhead will be used as the acting 
Timeline In point.

 > If you set a Timeline In point but no Timeline Out point: The whole range from the In to Out 
points of the source clip is edited into the Timeline such that the Source In point is aligned 
with the Timeline In point.

 > If you set a Timeline Out point but no Timeline In point: The incoming source clip will be 
backtimed so the Out point of the source clip is aligned with the Timeline Out point.

 > If you set Timeline In and Out points but only a Source Out point: In this case, the incoming 
source clip will also be backtimed so the Out point of the source clip is aligned with the 
Timeline Out point, with the Timeline edit points defining the duration of the source clip 
being edited.

 > If you set all four Source In and Out and Timeline In and Out edit points: The Timeline edit 
points dictate the duration of source clip that is edited into the Timeline, and the frame at 
the Source In point is aligned with the Timeline In point.

Tip: If you want to use all four Source and Timeline edit points to retime a source clip to fit into a 
specific range of the Timeline, use a Fit-to-Fill edit instead of an Overwrite edit.

The following sections provide common examples of three-point editing when performing edits in 
the middle of a previously edited timeline.
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Editing a Specific Range of the Source Clip Into the Timeline

In this example, you have a specific range of source media that you need to edit into the Timeline, 
and you don’t particularly care what gets overwritten in the Timeline by the incoming clip.

1. Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

2. To set where you want the incoming clip to go, set the destination control to the tracks you 
want to edit onto, and then do one of the following:

 >Move the Timeline playhead to the frame you want to use as the Timeline In point for the edit.

 > Set a Timeline In point for the edit.

3. To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Setting source clip In and Out points

Setting a Timeline In point
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Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline

In this example, you have a section of a clip or a gap in the edited sequence of clips in the Timeline 
that you want to fill with as much of the current source clip as it will take to “plug the hole.”

1. Set an In point in the source clip, if necessary, to define the first frame of the range of source 
media that you want to edit into the Timeline.

2. Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

The resulting edit; the duration of the source clip defines the duration of the edit

Setting a source clip In point only
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3. To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Backtiming a Source Clip When Editing Into the Timeline

In this last example, you’ve got a specific moment in the second half of a source clip that you need 
to align with an out point in the Timeline, such that the remaining duration of the incoming clip 
overwrites the edited sequence of clips from the right to the left. This is referred to as backtiming, 
when you’re lining up a Source Out point with a Timeline Out point in order to make an edit, and 
can be set up one of two ways.

Setting both In and Out points of the Timeline for a gap

The resulting edit; the duration of the timeline edit points define how much of the source clip is edited
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Backtiming method one:

1. Set In and Out points in the source clip, either in the Media Pool or in the Source Viewer.

2.  Set an Out point in the Timeline, at the frame where you want the corresponding Out point of 
the incoming source clip to be aligned.

3. To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Backtiming method two:

1. Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2. Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

Setting up a backtimed match-on-action edit via In and Out points in the Source Viewer, and an Out point in the Timeline

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline
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3. To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Setting up a backtimed edit by setting an Out point in the Source Viewer, and In and Out points in the Timeline  

to define the duration of the edit

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline
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This section covers the different types of edits that are available for cutting source clips into the 
currently open timeline.

Overwrite Edits

The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in the 
Timeline previously with the incoming source clip taking the place of whatever was there. Overwrite 
edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1. Move the playhead to the frame of the Timeline where you want to insert a clip.

2. Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3. Select a single clip in the Media Pool to open it into the Source Viewer, then set In and Out 
points to define the range of media you want to insert.

4. To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto either the Overwrite overlay in the Timeline Viewer, or onto any area of the Timeline 
Viewer outside the editing overlays.

The selected clips in the Media Pool are overwrite edited to the selected track starting at the 
position of the playhead, eliminating whatever was there originally while adding incoming clip. No 
other clips are rippled during this operation.

Types of Edits

Before and after an overwrite edit, the timeline duration stays the same
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Insert Edits

An insert edit splits whatever media is already in the Timeline at the position of the playhead, and 
pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the 
Insert Edit point you’re making, pushing them further to the right by the duration of the incoming 
source clip. However, clips in any tracks of the Timeline that overlap to the left of the Insert Edit 
point aren’t rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and A1 
of the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the left of 
the insert edit point, the music clip remains where it is, but the other clips on track V1 and A1 that 
are to the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1. Move the playhead to the frame of the Timeline where you want to insert a clip.

2. Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3. If necessary, set In and Out points in the clip or clips you want to insert edit into the Timeline 
using the controls of the Media Pool or the Source Viewer. 

4. Do one of the following:

 > Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
“Insert Selected Clips to Timeline.” 

 >Open a clip into the Source Viewer, set In and Out points to define the range of media you 
want to insert, and then click the Insert Edit button in the toolbar, press the F9 key, or drag 
any clip onto the Insert overlay in the Timeline Viewer.

 The selected clips are insert edited to the selected track at the position of the playhead, 
pushing all other media in the destination track back by the total duration of the selected 
clips, except for clips on other tracks that overlap to the left of the edit point (as seen by the 
overlapping music clip in the example below).
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Replace Edits

A replace edit automatically replaces a clip in the Timeline with a clip in the Source Viewer, using the 
duration of the Timeline clip to define the duration of the incoming media, and the positions of the 
Viewer and Timeline playheads to line up how the incoming media should be placed.

You can also use a replace edit to edit a clip into an empty track of the Timeline so that the frame 
at the position of the Source playhead is aligned with the Timeline playhead, and the In and Out 
points of the incoming clip fall where they may. This is useful when you want to “spot” a particular 
action of an alternate take or a cue in a sound effect to a specific frame of the Timeline.

Replace edits do not ripple the Timeline.

To replace a clip in the Timeline:

1. Move the playhead in the Timeline to the clip that you want to replace, and align it with a frame 
that you want to line up with a frame in the clip you want to replace edit into the Timeline.

2.  Click the appropriate audio and video destination controls of the track containing the clip you 
want to replace.

3.  Open a clip into the Source Viewer.

4.  Move the playhead in the Source Viewer to the frame that you want to line up with the frame 
at the position of the playhead in the Timeline.

Before and after an overwrite edit, the timeline gets longer as non-overlapping clips to the left of the edit point are 

pushed to the right
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5. Click the Replace Clip button, press F11, or drag any clip onto the Replace overlay in the 
Timeline Viewer.

 The clip in the Timeline is now replaced with the clip from the Media Pool, with the source 
frame at the Source Viewer playhead aligned with the frame at the Timeline playhead.

Move the playhead over the clip you need to replace, and position the Source Viewer playhead on the matching frame

The resulting replace edit
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Fit to Fill

Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit type that 
retimes clips at the same time as they’re being edited. By setting In and Out points in the incoming 
source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the 
timing of the specified range of source media to cover the entire specified range of the Timeline. In 
the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, 
and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also 
incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source 
clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit to fill edits do not ripple the Timeline.

To use Fit to fill to edit a clip into the Timeline:

1. Set both In and Out points in the Timeline to define the duration you want to fill with the 
incoming source clip.

Setting timeline In and Out points to mark a gap
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2. Set In and Out points in a longer or shorter source clip that you want to fill into the available 
space. 

3. Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks. 

4. Drag any clip onto the Fit to Fill overlay in the Timeline Viewer, or press Shift-F11.

 The incoming source clip is retimed, if necessary, to fit into the specified duration of the Timeline.

Setting In and Out points in a source clip to define a shorter duration

The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap
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Place On Top

Place-on-top edits automatically superimpose clips onto the first empty track above any other clips 
in the Timeline that either intersect the playhead or fall in between the currently set Timeline In 
and Out points, regardless of the current track specified by the destination controls. It’s designed 
to make it easy to superimpose titles and other clips you want to composite over another clip, or to 
add additional versions of clips such as VFX on top of previous versions that you want to preserve.

Place-on-top edits create new timeline tracks if necessary, and do not ripple the Timeline.

To use Place-on-top to edit a clip into the Timeline:

1. To choose where in the Timeline the clip will be “placed on top,” do one of the following:

 Move the playhead to intersect the clip you want to edit the incoming source clip on top of.

 Set In and Out points in the Timeline to define the duration within which you want to place the 
incoming source on top.

2.  Set In and Out points in a source clip that you want to edit.

3.  Drag any clip onto the Place on Top overlay in the Timeline Viewer, or press F12.

 > Incoming video clips will be edited to the topmost video track so they are above any 
previously existing video in the Timeline. Incoming audio clips are edited to the bottom-
most audio track so they are below any previously existing audio. If necessary, new video 
and/or audio tracks will be created automatically to hold the new incoming clip.

Before and after using Place-on-top
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Append at End

Append at End always puts the edited clip at the very end of the current timeline. It’s a very useful 
edit type when you’re quickly stringing together a series of clips.

To use Append at End to edit a clip into the Timeline:

1. Set In and Out points in a source clip that you want to add to the end of the current timeline.

2.  Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks.

3.  Choose Edit > Append at End, or press Shift-F12.

 Incoming video clips are added after the very end of the last clip in the Timeline.
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Match frame operations are a terrific time saver when you need to match the original source clip to 
a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same clip in 
the Timeline. With a single command, you can match one clip to another in order to set up a new 
edit to take care of a variety of tasks.

Matching From the Timeline

A classic example of using Match Frame is when you originally edited a video clip into the Timeline 
without its corresponding audio, and you later decide you want that audio in the Timeline after all. 
An easy fix is to move the playhead in the Timeline to intersect the clip you need to fix, and use 
the Match Frame command to automatically load the original source media for that clip into the 
Source Viewer, setting Source In and Out points that match those of the timeline clip, and putting 
the Source playhead at the same frame as the Timeline playhead. At that point, you can simply edit 
the source audio and video back into the timeline to overwrite the video-only clip you started with, 
confident that you’re editing exactly the same range of media at the same place.

To use Match Frame in the Timeline to find a source clip:

1. Move the Timeline playhead to intersect the clip you want to target.

2. If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target for Match Frame 
operations. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

Placing the playhead over a clip to match frame

Match Frame Operations
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3. Do one of the following:

 > Double-click the clip in the Timeline. 

 > Click the Match Frame button at the bottom right of the Timeline Viewer (it’s at the left of 
the In and Out buttons).

 > Press the F key.

 The original source media for that clip is automatically loaded into the Source Viewer, with In 
and Out points that match those of the targeted timeline clip; the Source playhead is at the 
same frame as the Timeline playhead.

Matching From a Source Clip

Match Frame also works in the opposite direction. You can open a source clip into the Source 
Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame to 
automatically find the next clip in the Timeline with media found within the source clip.

To use Match Frame in the Source Viewer to find a clip in the Timeline:

1. Open a clip in the Source Viewer that includes a range of media that’s already been edited 
into the Timeline. If no part of the source clip has been edited into the Timeline, source match 
framing won’t work.

2.  Move the Source Viewer playhead to a frame that you want to find in the Timeline. Again, if the 
frame at the position of the playhead in the Source Viewer hasn’t already been edited into the 
Timeline, the Source Match Frame command won’t work.

3.  Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of the In 
and Out buttons), or press the F key.

 The Timeline playhead automatically moves to the clip and frame after the current playhead 
position that matches the clip in the Source Viewer.

Placing the playhead over a clip to match frame
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Once you’ve assembled a group of clips in the Timeline, you’ll probably need to manipulate them 
further, moving, deleting, trimming, and otherwise adjusting the clips in the Timeline to make the 
edit play with the pacing and verve you require.

Selecting Clips in the Timeline

Many operations require you to make a selection first, to define the scope of what you’re about to 
do. There are many ways to do so.

Selections you can make using the mouse:

 > To select one clip: Click a clip with the mouse. 

 > To select a continuous range of clips: Drag a bounding box from an empty area of the 
Timeline to surround a group of clips. 

 > To select a discontinuous range of clips: Command-click any clips to select them no matter 
where they appear on the Timeline.

Selecting a continuous range of clips in the timeline

Selecting a discontinuous range of clips in the timeline

Working in the Timeline and Altering Edits
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Selections you can make using the keyboard:

 > To select one clip: Using the keyboard, make sure the Auto Select button for the track the 
clip is on is enabled, then move the playhead over that clip and press Shift-V.

 > To select all clips forward on the current track: Move the playhead to the first clip you want 
to include in the selection, then press the Y key to select that clip and every clip to its right 
in the same track of the Timeline.

 > To select all clips forward of the playhead on all tracks: Move the playhead to the first clip 
you want to include in the selection, then press Option-Y to select that clip and every clip 
to its right in all tracks of the Timeline.

 > To select all clips in the Timeline: Make sure the Timeline has focus, then press Command-A.

To move the selection to other clips:

 > Select a clip, then use the Left Arrow and Right Arrow keys to change the selection to the 
previous or next clip among all tracks with Auto Select turned on.

To deselect all clips:

 > Using the mouse: Click in any empty area of the Timeline.

 > Using the keyboard: Press Shift-Command-A.

Using the Timeline Auto Select Controls to Define Selections

The Timeline Auto Select controls give you a way of specifying which tracks will be either affected 
or considered during operations in which there are multiple superimposed clips on multiple tracks 
of the Timeline. In the easiest example, if you have two superimposed clips, and you want to delete 
the media from only the clip on track V1, you can turn off the Auto Select control for track V2, set 
Timeline In and Out points to define the range of the clip you want to delete, and then when you 
press the delete key, only the media on the Auto Select-enabled track is deleted.

Before and After deleting a clip with Auto Select on Tracks V1, A2, and A3 turned off
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Another type of operation affected by Auto Select is when using the Mark Clip command, again on 
a section of the Timeline where there are multiple superimposed clips, each of which has a different 
duration. Ordinarily, the first and last frames of the clip on the lowest track is used to set Timeline In 
and Out points when using Mark Clip. 

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest 
video track with Auto Select still enabled is used as the target clip for the Mark Clip operation. In 
this example, the shorter clip on track V2 now sets the locations of the In and Out points.

Using Mark Clip with all Auto Select controls enabled

Using Mark Clip with all Auto Select controls enabled
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Methods of enabling and disabling the Auto Select controls:

 > To toggle Auto Select for any track: Click any track’s Auto Select control.

 > To toggle Auto Select for video tracks: Press Option-F1 through F8 to toggle Auto Select 
for tracks V1 through V8. 

 > To toggle Auto Select for all video tracks off and on: Press Option-8.

 > To toggle Auto Select for audio tracks 1-9: Press Option-Command-F1 through F8. 

 > To toggle all Auto Select tracks off and on: Press Option-Command-F9.

 > To “solo” Auto Select for a track and disable Auto Select on all other tracks: Option-click 
any Auto Select control to leave that control on while turning off all other Auto Select 
controls of that type (video or audio).

 > To turn all audio or video Auto Select controls on and off: Shift-click any video or audio 
Auto Select control to toggle on or off all Auto Select controls of that type (video or audio).

The following operations are affected by the state of each track’s Auto Select control:

 > Deleting clips: When using Timeline In and Out points to delete a range of media from the 
Timeline, only media on tracks with an enabled Auto Select control will be deleted.

 > Deleting gaps: When selecting and deleting gaps in the Timeline, clips on other tracks 
that overlap the selected gap will also be deleted on tracks with an enabled Auto Select 
control. Media to the right of affected tracks will ripple left to close the gap.

 > Selecting clips using the keyboard: When a clip is selected, you can press the Up Arrow 
and Down Arrow keys to move the selection from clip to edit clip, but clips on tracks with a 
disabled Auto Select control are not seen by this operation.

 > Using Mark Clip: When making a Mark Clip operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

 >Match Frame: When making a Match Frame operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

Deleting Clips From the Timeline

There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, 
you can perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving a 
gap. Using the Forward Delete key, you can perform a “ripple delete,” removing unwanted clips 
and closing the gap by rippling the rest of the edited timeline to the right of the deleted clip/s by 
moving it to the left.
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Deleting clips as a “lift edit” operation:

 > To remove one or more clips from the timeline, leaving a gap: Select a clip in the Timeline, 
or Shift-click or Command-click to select the clips you want to remove, and press the Delete 
key (or right-click the selection and choose Delete).

 > To remove a range of media from the timeline on multiple tracks, leaving a gap: Set Timeline 
In and Out points defining the range of media you want to delete, then turn off the Auto 
Select controls of any tracks with media you want to preserve, and press the Delete key (or 
right-click the selection and choose Delete).

Deleting clips as a “ripple delete” operation:

 > To delete one or more clips and close the gap by rippling the timeline left: Select a clip in 
the Timeline, or Shift-click or Command-click to select the clips you want to remove, and 
press the Forward Delete key.

 > To delete a range of media and close the gap by rippling the timeline left: Set Timeline In 
and Out points defining the range of media you want to delete, then turn off the Auto Select 
controls of any tracks with media you want to preserve, and press the Forward Delete key.

Deleting a range of clips and leaving a gap
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As with any ripple operation, any clips that overlap the affected range of media to the left are 
unaffected.

Selecting and Deleting Gaps in the Timeline

You can select gap the same way you select clips, except that you can only select one gap at a time. 
The principal reason to select gap is to delete it, in the process rippling the timeline to close the 
gap. In the following example, there’s a gap between two clips on track V1 that you’d like to close.

Deleting a range of clips and rippling the timeline to close the gap

Selecting a Gap On Track V1
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By clicking to select that gap, you can press the Delete key to close the gap, and the rest of the 
edited clips to the right of the selected gap will ripple left to close the gap. If you select a gap in a 
timeline that has clips on multiple tracks, the effect of deleting it depends on the state of the Auto 
Select controls for each track in the timeline.

 > All tracks with Auto Select enabled: The range of media that overlaps the selected gap will 
also be deleted.

 > All tracks with Auto Select disabled: The range of media that overlaps the selected gap will 
be left intact.

Selecting Edits in the Timeline

A variety of trimming methods require you to select an edit point, or part of an edit point, in order 
to resize, ripple, or roll an edit. You can do so using the mouse, or using the keyboard.

Methods for selecting edit points using the mouse:

 > To select an edit to roll: Move the mouse to the center of an edit point, and when the ripple 
cursor appears, click to select the edit.

 > To select just the incoming or outgoing half of an edit point to resize or ripple: Move the 
mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, 
click to select that portion of the edit.

Selecting An Edit Point To Roll
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To select an edit point using the keyboard:

1. Move the Timeline playhead close to the edit point you want to select.

2. Press the V key to select the nearest edit point to the playhead on the lowest track with Auto 
Select enabled. If there are overlapping superimposed clips on multiple tracks, turn off the 
Auto Select controls of tracks with edits you don’t want to select (you can solo a track’s Auto 
Select state by Option-clicking its Auto Select button).

3. Initially, the entire edit is selected, in preparation for a roll edit. To toggle among selecting the 
outgoing half, incoming half, and the entire edit, press the U key.

To move the selection to another edit:

 > Select an edit point, then use the Left Arrow and Right Arrow keys to change the selection 
to the previous or next edit point among all tracks with Auto Select turned on.

To deselect all edit points:

 > Using the mouse: Click in any empty area of the Timeline.

 > Using the keyboard: Press Shift-Command-A.

Linking and Unlinking Audio and Video

While selecting edits and clips, you can also choose whether the video and audio associated with a 
clip should be selected together (linked) or not. This determines whether operations performed to 
the video of a clip automatically affect the audio of the clip, and vice versa. In most instances, you’ll 
probably want to leave Audio/Video Linking turned on, so that selecting the video of a clip to move 
it elsewhere in the timeline also results in the audio being selected and moved at the same time. 
Disabling A/V linking in this case could cause your video and audio to go out of sync undesirably.

Selecting Incoming or Outgoing Halves of an Edit Point to Resize or Ripple
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However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V 
relationship, such as when you want to create a split edit, where a clip’s audio In point is at a different 
frame then the video In point. In this case, you can suspend Audio/Video Linking to select just the 
audio In point, then roll it either further back or forward to create the split, without changing the In 
point of that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Audio/Video Linking is visible via the chain-link button at the right of the toolbar.

To turn Audio/Video Linking off and on:

 > Click the Link Audio/Video button (or press Shift-Command-L).

To temporarily suspend Audio/Video Linking while making a selection:

 > Press the Option key while clicking a clip or edit point to select the video without selecting 
the audio, or vice versa.

Methods of permanently changing Audio/Video Linking in the Timeline:

 > To unlink audio and video from one another: Select a clip, then right-click it and choose Link 
from the contextual menu (or press Command-L). Unlinked clips do not appear with a dot 
before the clip name in the Timeline.

 > To link audio and video clips to one another: Command-click an audio clip and a video clip so 
they’re both selected, then right-click the selected clips and choose Link from the contextual 
menu (or press Command-L). A dot appears before the name of linked clips in the Timeline.

The Audio/Video Linking button

Left - linked video and audio with a dot to the left of the name, Right - unlinked audio and video has no dot
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Dealing with Audio Video Sync Offsets

Audio/Video sync is one of the most important things to maintain in any edited program. However, 
there are times when you may want to override the sync relationship of a clip’s audio and video to 
make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Audio/Video Linking and then move the audio or video of a clip independently of its 
linked video or audio counterpart, you’ll see red windows overlapping the clip names that display 
the timecode offset by which the audio and video of that clip are out of sync. In the following 
example, the audio and video of a clip have been moved out of sync by Option-clicking the video 
and dragging it to the right.

Locking Tracks

Another step you can take to prepare before an edit is to lock tracks with media that you don’t want 
to be affected by operations you’re about to perform. For example, if you have a complex set of 
music edits on track A3 that you don’t want to be affected by operations that will ripple the timeline, 
you can lock track A3 so those clips remain unaffected.

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. 
Furthermore, parameters of locked clips cannot be edited in the Inspector. However, clips on locked 
tracks can be graded and otherwise modified in the Color page.

To toggle the lock or unlock state of tracks, do one of the following:

 > Click any track’s lock control.

 > Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.

 > Press Option-Shift-9 to lock or unlock all video tracks.

 > Press Option-Shift-F1 though F8 to lock or unlock tracks A1 through A8.

 > Press Option-Shift-8 to lock or unlock all audio tracks.

Sync markers on a clip with audio and video out of sync
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Moving and Trimming Clips in Normal Edit Mode

After editing a series of clips into a timeline, the next thing even the most careful of editors probably 
needs to do is to start making changes. The simplest changes are made in Normal Edit Mode, using 
the regular arrow pointer. 

This is the default mode when you open Resolve, and allows you to move clips to other places in the 
timeline, resize them to make them longer or shorter, and roll the edit points between two clips to 
move the edit to happen earlier or later.

Manipulating clips using the mouse:

1. Click the ”Normal Edit Mode” tool (the arrow).

2. Do one of the following:

 > To move clips in the Timeline: Drag any clip in the timeline to any other position. If you drag 
a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re dropping 
it onto.

The Normal Edit mode button at left, the Trim mode button at right

Moving a clip in the timeline to overwrite part of another clip, a tooltip shows you how many frames you’ve moved
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 > To shorten or lengthen clips: Move the Normal Edit Mode pointer over the beginning or 
end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or 
right to change the clip’s length. 

 > To roll any edit: Move the Normal Edit Mode pointer over any edit point, and when it turns 
into the Roll Edit cursor, drag it to the left or right to move the edit point while simultaneously 
resizing the outgoing and incoming edits points of the two clips surrounding it.

Resizing a clip in the timeline to create a gap, a tooltip shows the offset, and outlines show you how much media 

is available in the clip being adjusted

Rolling an edit, a tooltip shows the offset, and an outline shows the available area you can roll within
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Manipulating clips using the keyboard:

1. Press A to choose ”Normal Edit Mode.”

2. Do one of the following:

 > To roll any edit: Select the closest edit point to the playhead using the V key, moving the 
selection to another edit if necessary using the Left Arrow and Right Arrow keys, and then 
press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the 
selected edit to the left or right. Shift-Comma and Shift-Period nudges by 10 frames.

 > To shorten or lengthen clips: Select the closest edit point to the playhead using the V key, 
then use the U key to toggle the selection among the end of the outgoing clip and the 
beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or Period 
key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge one 
end of a clip to overlap another, the clip you’re nudging overwrites the adjacent clip. Shift-
Comma and Shift-Period nudges by 10 frames.

 > To move clips in the Timeline: To select a clip in preparation for moving it, either click it, or 
move the playhead over it and press Shift-V. Then press the comma (nudge 1 frame left) 
or period (nudge 1 frame right) to move the clip to the left or right. If you nudge a clip to 
overlap another clip, the clip you’re nudging overwrites the adjacent clip. Shift-Comma and 
Shift-Period nudges by 10 frames.

Splitting and Joining Clips

In many situations you may find yourself splitting clips in order to separate multiple clips that were 
inadvertently baked together, or to cut up clips into sections that you’re planning on applying 
different effects to or grading differently.

Methods of splitting and joining clips:

 > To split a clip once: Drag the playhead to the frame where you want to split a clip, and press 
Command-B.

 > To split many clips: Click the Razor Edit mode button (or press B), and then click clips in the 
Timeline to split as many clips as you want.

 > To split clips using the DaVinci control surface on the Color Page: Move the playhead to the 
frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-Bar panel.

 > To join clips using the DaVinci control surface on the Color Page: Move the playhead to the 
edit point you want to join, and press SHIFT UP and JOIN/REDO on the T-Bar panel. Both 
clips must be from the same media file, and the frames to either side of the edit point need 
to be continuous for those clips to be joined.
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Copying and Pasting Clips in the Timeline

Clips can be cut, copied, and pasted using standard keyboard shortcuts. You can cut or copy one 
clip or a selection of several, and you can also choose to copy or cut just the video or audio media 
of a clip. When pasting, you can paste to the same timeline, or to a different timeline if you want to 
move media from one to another.

Methods of doing cut, copy, and paste:

 > To Cut one or more clips, leaving a gap: Make a selection, and press Command-X.

 > To Copy one or more clips: Make a selection, and press Command-C.

 > To Paste one or more clips to the same track: Move the playhead to the frame where you 
want the pasted selection to start, and press Command-V. Pasted clips overwrite any clips 
in that track that are in the way.

 > To Paste one or more clips to a different track: Assign the destination control to the track you 
want to paste to, then move the playhead to the frame where you want the pasted selection to 
start, and press Command-V. Pasted clips overwrite any clips in that track that are in the way.

Duplicating Clips in the Timeline

Clips can be duplicated by making a selection, and then Option-dragging the selected clips to 
another position and/or track in the timeline. 

Flagging and Marking Clips for Reference

You can call attention to different clips and frames using flags and markers. Flags are meant to mark 
an entire clip, and they also flag every other clip in the Timeline that shares the same Media Pool 
source clip, making this a handy way of quickly identifying which clips in a given timeline come from 
the same Media Pool source.

Markers, on the other hand, mark a particular frame within a single clip only. You can apply multiple 
flags and markers to clips, with a variety of colors to choose from. Both flags and markers are useful 
for timeline filtering, sorting by column in the Media Pool, and a variety of other operations.

The Flag and Marker buttons and pop-ups
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Methods for flagging and marking clips:

 > To flag a clip: Select one or more clips, and either click the Flag button to flag that clip with 
the current color, or click the Flag pop-up in the toolbar to choose a different color and 
then click the Flag button. Flags appear in the Timeline superimposed in the name bar of 
each clip.

 > To remove all flags from a clip: Select one or more clips with flags you want to remove, then 
click the Flag pop-up in the toolbar, and choose the top “Clear All” option.

 > To mark a clip: Select one or more clips you want to mark, and then move the playhead to 
any clip in the Timeline, and click the Marker button (or press M) to place a marker at that 
frame, using the current color. You can also click the Marker pop-up to choose a different 
color, and then click the Marker button. Markers appear in the Timeline at the top of the 
clip to which they’re applied.

 > To remove all markers from a clip: Select one or more clips with markers you want to remove, 
then click the Marker pop-up, and choose the top “marker with an x” option.

Marking the Timeline

You can also place markers of any color into the Timeline ruler, to denote specific times for  
future reference.

Methods for Marking the Timeline:

 > To mark the Timeline: Make sure all clips are deselected, then click the Marker button (or 
press M) to place a marker of the currently selected color in the Timeline ruler.

 > To remove all marks from the Timeline: With all clips deselected, choose Clear All from the 
marker pop-up menu in the Toolbar.
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While you can make most changes you want in the Timeline using the selection and razor blade 
tools, there is a dedicated Trim mode in which you can perform more sophisticated trim operations 
in fewer steps using either the Trim tool or the keyboard, depending on how you like to work. 

To enter Trim Edit mode:

 > Click the Trim Edit button, or press the T key.

When trimming using the mouse, you can perform every kind of trim operation that’s available, 
using one tool, simply by dragging on the appropriate area of a clip in the Timeline.

Methods of trimming with the mouse in Trim Edit mode:

 > To slip a clip: To slip a clip’s range of content without changing its position in the Timeline, 
click the middle top region of a clip, and then drag to the left or right to “slip” the clip to 
contain a different range of frames. A dashed overlay shows the total duration of media 
available for you to slip with, which moves left and right as you drag.

Using Trim Mode and the Trim Tool

Clicking the top clip area before a slide, an overlay shows the clip’s available range of media

After dragging to slip, clips don’t move, but the slipped clip’s range of media has changed
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 > To slide a clip: To slide a clip, moving it to another position in the Timeline while 
simultaneously adjusting the Out point of the previous clip and the In point of the next 
clip to accommodate the change in position of the current clip being dragged, click the 
bottom middle name bar of the clip and drag it to another position.

 > To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In 
point of the incoming clip at the same time, drag an edit point between two clips to the left 
or right. (Roll edits can also be done in Normal Edit mode.)

Clicking the bottom name bar of a clip before a slide

After dragging to slide, the selected clip is at a new location, surrounding clips filled the gap
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 > Ripple Edit: To ripple the outgoing or incoming part of an edit to add or remove media to 
a clip while simultaneously moving all other clips at the left in the Timeline to make room, 
click the Ripple tool, and drag an edit point to a new position in the Timeline.

Selected edit point before roll

Edit point moved further to the right, both adjacent clips resized to prevent gap

Selected incoming half of an edit point before ripple
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During a ripple edit, if any superimposed video or audio clip overlaps the clip point being 
rippled and extends to the left of it, that overlapping clip is not moved. This can be seen in 
the previous example via the audio clip at the bottom of the Timeline, which stays in place 
even as the clips on track V1 and A1 are rippled.

You can also trim more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1. Press T to select the Trim tool. 

2. To trim the selection, do one of the following:

 > To slide a clip: Press Shift-V to select a clip, and press the Comma key to slip it one frame to 
the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-Period slips 
the clip in 10 frame increments.

 > To slip a clip: Press Shift-V to select a clip, then press the S key to toggle to Slip mode 
(pressing S again toggles back to slide mode) and press Comma or Period to slide its 
contents to the left or right. Shift-Option-Comma and Shift-Option-Period slides the 
contents in 10 frame increments.

 > To roll an edit: Press V to select an edit point, then press the Comma key to nudge it one 
frame to the left, or the Period to nudge it one frame to the right. Shift-Comma and Shift-
Period rolls the edit in 10 frame increments.

 > To ripple an edit: Press V to select an edit point, then press U to select either the incoming 
or outgoing side of the edit by itself. Then, press the Comma key to ripple the selected In 
or Out point of the clip to the left, or the Period to ripple it one frame to the right. Shift-
Comma and Shift-Period ripples in 10 frame increments.

Rippled clip is shorter, the rest of the timeline has moved left to fill the gap



EDIT4

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

234

Important: While the Slip, Roll, and Slide tools will change the sync relationship of the clips you’re 
adjusting with a matching soundtrack, the rest of the timeline won’t be affected. Using the Ripple 
tool can alter the overall sync relationship of large portions of your timeline and its matching 
soundtrack, so you should use it with extreme care in situations when you’re grading a locked edit 
with audio that is being mixed at the same time.
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As you work in the Timeline, you’ll find there are times when you want to disable clips that you 
don’t want to appear during playback, without actually removing them from the edit. For example, 
you may decide to disable superimposed clips that are positioned as insert shots in the middle of 
a scene because of a client’s notes, but you don’t want to eliminate the clips because they might 
change their minds.

In another example, you’ve edited a series of titles on track V4, but you need to disable track V4 in 
order to output a textless version of the movie as a deliverable.

When a clip or track is disabled, it appears dimmed, and the disabled clips don’t appear in the Color 
page, and aren’t output to tape or rendered to disk in the Deliver page unless re-enabled first. 

To disable/enable one or more clips in the Timeline:

 > Select one or more clips, then right-click the selection and check or uncheck Clip Enable in 
the contextual menu, or press D to toggle a clip’s enabled state. 

To disable/enable an entire track:

 > Click the track enable button.

A disabled clip

A disabled track

Enabling and Disabling Clips and Tracks



EDIT4

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

236

Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions of a 
particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes where you or 
the client can’t quite decide which one is the best, or for maintaining multiple versions of VFX clips 
that are going through different iterations. 

When you place a number of clips inside of a Take Selector, only one clip appears in the Timeline, 
but you can open that Take Selector and switch to any other take or version that’s stored within to 
switch which clip appears in the Timeline whenever you want.

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips 
inside of the Take Selector, you can slip each clip’s range of media, or choose a new clip to appear 
in the Timeline, before closing the Take Selector.

When closed, multi-take clips can be edited, trimmed, graded, and rendered like any other clip in 
the Timeline. A Take Selector badge appears to the left of the name of a clip to which it’s applied to 
show its status; double-clicking this badge opens the Take Selector so you can adjust its contents.

Methods of using Take Selectors:

 > To create a Take Selector: Right-click any clip that’s not a Title or Generator, and choose 
Take Selector from the contextual menu. The Take Selector interface appears, disabling 
the rest of the timeline temporarily while you work with the Take Selector’s contents.

Using a Take Selector

A Take Selector, shown open, with several alternate takes placed within

When closed, a take selector appears as a regular clip with a badge
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 > To populate a Take Selector: Drag any clip from the Media Pool into the Take Selector, and 
it appears “stacked” on top of the original clip in the Timeline.

 > To choose the current clip: Click any clip so that it’s highlighted in blue, and click the close 
button at the upper-left corner of the Take Selector. When next you open the Take Selector, 
the current clip appears at the bottom of the stack, with a star at the upper-left corner.

 > To slip a clip within the Take Selector: Drag any clip to the left or right to slip the range of 
media that appears within the Take Selector’s duration in the Timeline.

 > To remove a clip from a Take Selector: Click the clip you want to remove to select it, then 
click the garbage can button at the upper-right corner of the Take Selector.

 > To close a Take Selector: Click the X close button.

 > To reopen a Take Selector: Double-click the take selector badge at the left of a clip’s name, 
or right-click a multi-take clip and choose Take Selector from the contextual menu.

 > To eliminate a Take Selector: Close the Take Selector, if open, then right-click that clip in the 
Timeline and choose Finalize Take from the contextual menu.
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DaVinci Resolve has several methods of locating clips and media, to help you troubleshoot problem 
timelines, or to find media that you want to edit into a timeline differently.

Methods of finding clips:

 > To locate a clip in the Edit Index via the Timeline: Move the Timeline playhead to intersect 
a clip you want to find in the Edit Index. That clip’s corresponding event (or events if the 
playhead intersects multiple clips) are automatically highlighted in the Edit Index list.

 > To locate a clip in the Timeline via the Edit Index: Click an event in the Edit Index and the 
Timeline playhead will automatically move to the In point of that clip.

 > To find a clip in the Timeline: Open the Edit Index, choose a criteria from the Search Options 
pop-up menu, and then type a search term in the Search field at the top right of the Edit 
Index. As soon as you start typing, all edit events that don’t match the search criteria are 
temporarily hidden. To show all of the clips in the Edit Index again, click the cancel button 
at the right of the search field.

 > To find a clip in the Media Pool: Open the Media Pool, if necessary. Then choose a criteria 
from the Search Options pop-up menu, and type a search term in the Search field at the 
top right of the Edit Index. As soon as you start typing, all clips that don’t match the search 
criteria are temporarily hidden.

 > To locate a timeline clip in the Media Pool: Right-click any clip in the Timeline, and choose 
Find in Media Pool. That clip appears highlighted in the Media Pool. 

 > To locate a media file in the Finder from the Media Pool: Right-click any clip in the Media 
Pool and choose Reveal in Finder. A Finder window, or its equivalent in Windows and Linux, 
opens to the directory with that clip, which appears highlighted.

Finding Media
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DaVinci Resolve supports a variety of transitions besides the traditional cross-dissolve, allowing for 
greater flexibility when finishing creative edits. All supported transitions appear within the Effects Pool.

The following procedures describe how to work with transitions in DaVinci Resolve.

Methods of working with transitions:

 > To add a transition by dragging it from the Effects Pool: Drag a video transition from the 
Effects Pool to an edit point in the Timeline so that it’s centered at, ends at, or starts at the 
edit point. If there is no overlap between the heads and tails of the two clips, you may not 
be able to add a transition where you want.

 > To change a transition type: Drag a different transition from the Effects Pool onto the 
current one in the Timeline.

 > To change a transition’s duration: Drag the beginning or end of the transition in the Timeline 
and drag it to be longer or shorter symmetrically about the current edit. Option-drag the 
beginning or end of a transition to move the center of the transition while resizing it.

 > To remove a transition: Select a transition in the Timeline and press the Delete key. Or, 
right-click a transition in the Timeline and choose Delete from the contextual menu.

The following are transitions that are available within Resolve, along with the parameters that are 
available from the Inspector:

 > Center Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
emerges from the middle of the screen.

Working With Transitions

A transition in the timeline
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 > Clock Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Angle specifies the starting angle of the wipe 
as it spins around the center of the screen. The Clockwise checkbox sets the direction of 
the clock wipe.

 > Edge Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
moves across the screen.

 > Venetian Blind Wipe: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Repeat specifies how many “blinds” 
appear within the wipe effect. Angle specifies the angle of this multi-wipe effect.

 > Additive Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition.

 > Cross Dissolve: Start Ratio lets you adjust how far along the transition is when it first begins, 
from the very beginning of the transition to 50 percent through the transition. End Ratio lets 
you adjust how far the transition gets at the very end, from a complete transition through 
50 percent of the transition. The Reverse checkbox reverses the direction of the transition.

 > Dip to Color Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition. Color lets you choose what color the dissolve dips to at the midpoint.

 > Cross Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the cross wipe begins, as X and Y coordinates on the screen.

 > Diamond Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the diamond-shaped wipe begins, as X and Y coordinates on the screen.

 >Oval Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which this circular wipe begins, as X and Y coordinates on the screen.



EDIT4

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

241

You can select a series of clips in the Timeline, whether they are edited one after the other in serial 
or superimposed and stacked in parallel, and turn them into a Compound Clip, which is a single clip 
in the Timeline that’s actually comprised of many other audio and video clips embedded inside. 
This allows you to work with a block of clips as if it were a single unit, governed by a single set of 
Inspector controls, and able to be connected to another clip in your timeline by a single transition.

Editing a compound clip works the same as editing any other type of clip. They can be edited, 
trimmed, and deleted using all the same methods.

To create a compound clip:

1. Select a range of clips.

2. Right-click one of the selected clips and choose New Compound Clip.

3. Enter a name and optional start timecode for the compound clip you want to create, and 
click Create.

Compound Clips

Selecting a range of clips to turn into a compound clip



EDIT4

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

242

 A compound clip is created which takes the place of the original clips you selected on the 
Timeline. Additionally, a copy of that compound clip appears in the currently selected bin of 
the Media Pool.

The resulting compound clip
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There’s a collection of titles and generators in the Toolbox that you can use to create leader 
when outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your  
program has.

Titles and generators can be edited much like any other clip. Furthermore, when selected, both titles 
and generators expose the same Composite, Transform, and Cropping parameter groups as any 
other clip; these parameters can be used to composite titles and fly them around in order to create 
different text effects.

Methods of adding and editing generators and titles:

 > To drag and drop a generator directly into the Timeline: If you simply drag and drop titles 
or generators into the Timeline, the default duration of the resulting clip is 20 seconds and 
20 frames.

 > To edit a generator using the edit overlays of the Timeline Viewer: Click the destination 
control of the clip you want to edit a generator into, then set Timeline In and Out points to 
define the duration of the resulting edit, and drag the generator you want to edit onto the 
edit overlay of the Timeline Viewer that corresponds to the type of edit you want to perform.

 > To edit the parameters of a generator or title: Open the Inspector, and select the generator 
or title you want to edit to open it into the Inspector.

When opened into the Inspector, titles expose a set of text parameters that allow you to style the 
contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so you 
can individually style words, lines, or paragraphs of text using the available parameters including 
Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and Shadow affect the 
entire title.

The available titles in the toolbox

Adding Titles and Generators
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The following titles are available:

 > Simple: Useful for creating titles consisting of one word, line, or paragraph of text. 
Parameters let you edit the content, position, font, size, alignment, anchoring, color, and 
drop shadow of the title.

 > Scroll: Automatically automates a scrolling title sequence from the bottom to the top of 
the screen. The duration of the generator clip in the Timeline determines the speed of the 
scroll. Shares parameters with the Simple title.

 > Lower 3rd: Automatically positions two lines of text at the bottom left corner of title safe. 
Shares two sets of text parameters, one for each line, with the Simple title.

 >M Lower 3rd: Automatically positions two lines of text at the bottom middle of title safe. 
Shares two sets of text parameters, one for each line, with the Simple title.

 > R Lower 3rd: Automatically positions two lines of text at the bottom right corner of title safe. 
Shares two sets of text parameters, one for each line, with the Simple title.

Generators, with the exception of Solid Color, lack editable parameters with the exception of the 
Composite, Transform, and Cropping parameters that are standard for every clip.

The following generators are available:

 >Gray Scale: A simple grayscale ramp from black to white.

 > EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

 > SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for NTSC-using countries.

 > 10 Step: A grayscale ramp segmented into 10 steps from black to white.

 > 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

 >Window: A simple white on black shape generator, defaulting to a white rectangle against 
a black background.

 > YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

 > Solid Color: A simple fullscreen color generator. A Color parameter lets you choose what 
color this generator outputs.
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In many workflows, various compositing effects are added to programs during the offline edit. 
Many of these can be imported into DaVinci Resolve, including composite modes, opacity settings, 
linear and nonlinear speed changes, and clips using alpha channels. Once in Resolve, you can make 
changes to these effects in the Edit page.

Using Stills

Prior to version 10, the use of stills in DaVinci Resolve was limited to image sequences wherein each 
still was exactly one frame in duration. In the current version, DaVinci Resolve is capable of having 
still image clips of any duration on the timeline, or importing still image clips along with XML or AAF 
project files, so long as they’re in a supported format. DaVinci Resolve supports the use of stills in 
the following formats:

If you edit a still image into the timeline, its initial duration will be one frame. However, by zooming 
in far enough, you’ll be able to use the selection tool to resize the Out point to any duration you 
require. Once edited into the timeline, still image clips have the same Composite, Transform, 
Cropping, and Speed Change attributes as any other clip.

Note: Only the bitmapped layers of Photoshop (.psd) files appear within DaVinci Resolve as a single 
clip in the Timeline. Text layers and layer effects are not supported.

Composite Modes and Transparency Effects

Composite modes are effects that use various mathematical operations to combine one superimposed 
clip with another, relying on standard image processing math for each color channel whereby black 
pixels have a value of 0, white pixels have a value of 1, and descending levels of gray are represented 
by decimal point values (for instance, 0.5 represents 50% gray). When using composite modes to 
blend two clips together on the Timeline, the three color channels of each pair of pixels are combined 
using that particular composite mode’s math. The results can create transparency effects, increase 
image exposure, and combine multiple images in many creative and useful ways.

Applying Effects in the Edit Page

File Format Alpha 

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No
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Two source clips combined with the Hardlight composite mode

When using composite modes, it’s easy to push parts of the resulting image above the maximum or 
below the minimum values for brightness. However, this image data is not clipped, even through such 
areas of the picture may appear flat white or black. Out-of-range data as a result of a composite mode 
effect is preserved, and may be retrieved by later image processing operations in the Color page.

When you import XML project files, Resolve imports whatever composite modes were used by clips 
in the original sequence. If necessary, you can then change a clip’s composite mode to one that will 
work better with whatever grade you’re creating. Of course, you can also add composite modes to 
clips that didn’t originally have them, adding new effects of your own. 

All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing already 
being done.

Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page using 
the Layer Mixer node, within which you can combine differently graded versions of an image in 
creative ways. For example, the Add and Overlay composite modes can be useful for creating glow 
effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.
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To set or change a composite mode for any clip:

 > Select a clip in the Timeline, then open the Inspector and choose one of the options from 
the Composite Mode pop-up menu.

To turn a clip’s composite mode off:

 > Select a clip in the Timeline, then open the Inspector and choose Normal from the 
Composite Mode pop-up menu.

There are ten composite modes to choose from. For clarity, simple image math is used to help 
explain the available Composite Mode effects.

 >Normal

No image compositing is done. The topmost image on the Timeline or the bottom input of 
the Layer Mixer node occupies the entire frame.

 > Add

Each pair of pixels in both superimposed layers is added together. Layer order does not 
matter. This can result in a dramatic brightening of light areas of both images with areas of 
the picture that are blown out to maximum white, and this effect is often used by adding 
the brighter part of an image to itself to create hot glow effects. Image data going above 
1.0 is preserved and may be retrieved by later color correction operations. On the other 
hand, black areas of either image do not alter the combined image at all (0 + n = n).

 > Subtract

Within each pair of pixels, those of the bottom layer are subtracted from those of the top. 
This can result in dark areas of the image that hit flat black, but image data going below 0 
is preserved and may be retrieved by later color correction operations.

 > Difference

The absolute value is taken of the top layer minus the bottom layer, and returned as the 
result, which is always a positive number. Layer order does not matter. This Blend mode 
is often used to compare two differently-processed versions of the same image to see if 
there are any alterations, and how large they are.

Composite mode and opacity controls in the timeline
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 >Multiply

Each pair of pixels is multiplied together. Layer order does not matter. This generally has the 
effect of emphasizing the darkest parts of both images in the resulting output; in particular 
black areas of either image are preserved (0 * n = 0) while white areas of either image have 
no effect on the output image (1 * n = n). Multiply is good for compositing darker elements 
in a field of white into an image, and can be used to emphasize the darkest parts of a noise, 
grain, or damage layer you’re blending with an image.

 > Screen

The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. 
Layer order does not matter. Screen is the inverse of Multiply, as it preserves the lightest 
parts of both images, and is useful when compositing lighter elements in a field of black 
into an image, and can be used to emphasize the lightest parts of a noise, grain, or damage 
layer you’re blending with an image.

 >Overlay

Overlay combines useful aspects of both the Screen and Multiply composite modes, based 
on the pixel values of the bottom most image on the Timeline; all bottom layer pixels above 
50% are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an 
excellent composite mode for combining a layer of noise, grain, or damage imagery with 
another clip, as it combines both images in visually useful ways throughout the tonal range 
of shadows through highlights.

 > Hardlight

Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while 
all bottom layer pixels 50% and below are Screened.

 > Softlight

A less intense method of applying the Hardlight composite mode that results in a more 
even blend between the two layers.

 > Darken

Each pair of pixels is compared, and the darker of the two is the output. Layer order does not 
matter. Darken is useful when you want the darker features of both layers to take precedence.

 > Lighten

Each pair of pixels is compared, and the lighter of the two is the output. Layer order does not 
matter. Lighten is useful when you want the lightest features of both layers to take precedence.

 > Unknown

When importing XML or AAF project files with composite modes that aren’t available in 
Resolve, the Composite Mode pop-up menu is set to Unknown; practically, this is the same 
as Normal.
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Opacity

Each clip has an Opacity parameter, available in the Inspector, that lets you make it more transparent, in 
a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less then 100, the selected 
clip is mixed with whatever clip is underneath it on the Timeline, according to the composite mode 
that’s currently used. If no clip appears underneath the Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or cross-
dissolves. Keyframing is covered in more detail later in this chapter.

To change a clip’s opacity:

 >Open the Inspector, then select the clip you want to adjust, and set the Opacity slider to 
create the desired amount of transparency.

Alpha Channel Support

If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against whatever 
is in the track underneath. There’s no need for you to do anything for this to work. 

However, if you want to disable the alpha channel for any clip, for example if a clip is being interpreted 
as having an alpha channel incorrectly, you can use the Find in Media Pool command to select that 
clip in the Media Pool, where you can right-click it and choose Change Alpha Mode > None.

Keying, External Mattes, and Window Compositing

It’s also possible to use the Qualifier, Power Window controls, and External Matte clips in the Color 
page to create compositing effects by connecting a key that you create to the optional Alpha 
Output that can be added to the Node Editor. In this way, you can pull a simple greenscreen key 
using a qualifier, do rotoscoping or matte work using a Power Window, or use an External Matte to 
composite two or more clips together, and see these effects on the Edit page.

Superimposing a clip with an alpha channel above automatically composites that clip against the clip beneath it
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For more information on use of the Alpha Output to do node-based compositing, see Chapter 8, 
“Manipulating and Combining Keys.”

Transform and Cropping

DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and 
then output at another resolution. This also makes it easy to output multiple versions of a program at 
different resolutions, for example, outputting both HD and SD sized versions of the same program.

DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of transform 
parameters, principally for use in storing sizing data imported from AAF or XML when you turn on 
the “Use sizing information” checkbox. This has the advantage of keeping these imported settings 
separate from the Input Sizing parameters found on the Color page, which are typically used by the 
colorist to make Pan and Scan adjustments of various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
timeline, zooming into clips, repositioning them to improve the composition, etcetera. While there 
is some overlap between these parameters and those in the sizing palette of the Color page, they’re 
both separate sets of parameters, so you can keep each set of adjustments separate. 

When the time comes to output your program, the final resolution of each clip is calculated taking into 
account the original resolution of the source media, the timeline resolution, image scaling settings, 
Edit page transforms, and Color page transforms, so that the final resolution correctly uses the 
cleanest geometric transformation based on the maximum resolution available to each source clip.

The Edit page transform group includes the following parameters, which are also editable in the 
Edit Sizing mode of the Sizing palette in the Color page:

 > Pan and Tilt: Moves the image within the frame, allowing pan and scan adjustments to be 
made. Pan moves the image in the X dimension, and Tilt moves the image in the Y dimension.

 > Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters 
can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the 
image in one direction only.

 > Rotation Angle: Rotates the image around the anchor point.

 > Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 
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The Edit page has an additional set of cropping parameters:

 > Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so that whatever is underneath shows through.

The Retime and Scaling group also has a single parameters that affects clip scale:

 > Scaling: Lets you choose how clips that don’t match the current project resolution are 
handled. The default setting is Project Settings, so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual 
method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch, which 
are explained in more detail in the 2D Transforms section of Chapter 8, “Color.”

You also have the option of transforming or cropping clips using the Transform/Crop button at the 
bottom left of the Timeline Viewer.

Transform controls in the Timeline Viewer
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To transform a clip using graphical controls in the Timeline Viewer:

1. Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it on; orange 
is enabled, gray is disabled. 

2. Choose either the Transform or Cropping mode from the pop-up menu if necessary to 
change modes. The appropriate on-screen controls appear to let you manipulate the clip 
with the mouse.

Onscreen controls for transforming and cropping in the Timeline Viewer

 >When in Transform mode, you can drag anywhere within the clip’s bounding box to adjust 
pan and tilt, drag any diagonal corner to proportionally resize, drag any side to squeeze or 
stretch just width or height, or drag the center handle to rotate.

 >When in Crop mode, each side has a handle for cropping.

3. If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-up to 
better see the on-screen controls if you’re rescaling the image.

4. When you’re finished, turn the Transform/Crop button off.
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Speed Effects

DaVinci Resolve is capable of reading linear speed effects from imported EDL, AAF, and XML 
projects, and nonlinear speed effects from XML and AAF project files. When speed effects are 
present, Resolve plays clips at the specified speed. You can also create speed effects of your own 
using controls in the Edit page. There are three methods of adjusting clip speed; using the inspector, 
using the Change Speed dialog, and using the Retiming effect in the Timeline.

Creating Simple Speed Effects

If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create 
a freeze frame, you can apply a simple speed effect using either the browser or the Change 
Speed dialog.

To change a clip’s speed, do one of the following:

 > Select a clip in the Timeline, open the Inspector, and scroll down to the Speed Change settings.

 > Right-click a clip in the Timeline, choose Change Speed, and use the controls of the Edit 
Speed Change dialog.

Speed Change operations have the following options:

 > Change Speed To parameter: Changes the speed of the selected clip by whatever 
percentage you like.

 > Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple 
the timeline, pushing or pulling all clips following the current one to accommodate the 
clip’s new size, then turn on the checkbox.

 > Freeze Current Frame checkbox: Changes the entire clip to a freeze frame of whichever 
frame is at the current position of the playhead.

 > Reverse Clip button: Clicking this button sets the current speed to a negative value, 
reversing the motion of the clip.

Speed effect parameters shown in the Speed dialog
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Clip Retiming Effects

Another method of altering clip speed in the Timeline is to apply the Retiming effect. This method 
of clip retiming provides a convenient control overlay that you can use to adjust clip speed directly in 
the timeline, and it also provides the controls that are needed for creating variable-speed effects.

To apply the Retiming effect to a clip:

 > Select a clip, and choose Edit > Retime Clip (Command-R).

The Retime controls appear over that clip in the timeline. They consist of a retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback (the 
default blue right-facing arrows indicate normal 100% playback) and a clip speed pop-up menu at 
the bottom center of the clip, which also shows the current speed of the clip.

Using the Retiming effect, you can either change the playback speed of the entire clip, insert freeze 
frames within the middle of the clip, or create your own variable speed effects using Speed Points 
to create differently timed speed segments.

To retime the entire clip:

 >Open the clip speed pop-up menu, and choose a new playback speed from the Change 
Speed menu.

 >Open the clip speed pop-up menu, and choose reverse segment to make the clip play in 
reverse. Reverse speed is shown in the retime control track as arrows facing left, instead 
of right.

 > Choose Reset Clip to return the clip to its original speed.

When you retime a clip, the clip speed pop-up menu displays the current speed of that segment, 
or of the entire clip if it’s all one segment. Additionally, the arrows in the retime control track 
show you the speed and direction of playback. For example, left-facing yellow arrows indicates 
reverse playback.

The speed effect controls in the timeline
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To create a freeze frame at a particular moment in time:

1. Move the playhead to the frame you want to freeze, within that clip. Ideally, this will be for an 
effect where you want a character in motion to suddenly stop at a particular frame.

2. Open the clip speed pop-up menu, and choose Freeze Frame. Two new speed points are 
added to the clip, defining a range within which the clip is frozen at that frame. This can be 
seen by the vertical red bars in the retime control track. Past the second speed point, the clip 
resumes playback from the next frame forward.

3. Drag the second speed point forward or back to define the duration of the freeze frame. The 
result is that the clip plays normally up until the first speed point, then freezes on that frame 
until the second speed point, at which playback resumes.

To create variable-speed effects:

1. Move the playhead to the frame at which you want to change the speed of the clip, and 
choose Add Speed Point from the clip speed pop-up menu.

2. Move the playhead forward to the next frame at which you want the clip speed to change 
again, and add another Speed Point. It takes a minimum of two Speed Points to create a 
speed effect.

Speed effect controls set to reverse

Speed effect controls set to insert a momentary freeze frame within the clip
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3. To alter the speed of the clip segment appearing between these two speed points, do one of 
the following:

 > Using the pointer, drag the second Speed Point to the right to slow down clip playback, or 
to the left to speed up clip playback within just that segment.

 > Using the clip speed pop-up menu, choose a new speed for that segment from the 
Change Speed pop-up menu. You can also set any segment to play in reverse by choosing 
Reverse Segment.

 When you create variable-speed effects, the arrows in the retime control track can help you 
keep track of what you’re doing. When clip speed is slowed down below 100%, the retime 
control track shows yellow playback triangles that are spaced apart. When clip speed is sped up 
above 100%, the retime control track shows yellow triangles that are bunched close together. 
At 100% normal speed, the retime control track shows blue, evenly spaced triangles.

4. To clear a Speed Point and eliminate that particular clip’s speed segment from the effect, 
choose Clear Speed Point from any clip speed pop-up menu to eliminate whichever speed 
point appears to its left.

There are two additional sets of commands for creating preset speed effects that use multiple 
Speed Points.

To add a rewind effect:

 >With a clip’s retime controls exposed, open any clip speed pop-up menu and choose a 
preset percentage from the rewind submenu. This results in two additional Speed Points 
being added after the rightmost Speed Point in the current segment, which creates the 
effect of the current segment playing in fast reverse for the chosen percentage, and then 
playing a second time from the beginning.

Speed controls set to ramp among three different playback speeds; arrow spacing shows the timing
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To add a speed ramp:

 >With a clip’s retime controls exposed, open any clip speed pop-up menu and choose one 
of the two options from the Speed Ramp submenu to replace the current speed effect with 
a series of five speed segments that start at 10% and increase progressively to 30%, 50%, 
70%, and then 90%. Once created, you can drag the Speed Points to customize this effect 
to create whatever durations you require.

When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again.

Speed effect controls before and after creating a “rewind” effect

Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed
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To close the Retiming controls in the timeline:

 > Click the X button at the upper left-hand corner of the retime control box.

When a retimed clip has its Retiming controls hidden, a retime badge appears to the left of that 
clip’s name in the timeline. You can reopen the Retiming controls whenever you need to make 
further changes.

To reopen the Retiming controls in the timeline:

 > Select the retimed clip, and either choose Edit > Retime Clip, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process parameter 
in the Inspector to define how that clip’s retiming is processed, using the low-quality Nearest option, 
using Frame Blending, or using Optical Flow. 

Speed Effect Processing

Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is 
processed in order to improve its visual playback quality, especially in the case of clips that are 
slowed down. There are two ways you can set this. First, there’s a project-wide setting available in 
the Master Project Settings. Secondly, you can change how clips are retimed via a per-clip setting 
available in the Inspector.

To change the Retime Process setting of an entire project:

1.  Open the Project Settings in the Master Project Settings panel.

2.  Scroll down to the bottom, and choose an option from the Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:

 > Select a clip, then open the Inspector and choose an option from the Retime Process pop-
up in the Retime and Scaling group.

The speed effect badge that shows a clip is being retimed
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Keyframing Effects in the Edit Page

Most parameters in the Inspector of the Edit page can be keyframed, in order to create animated 
effects such as zooming in via the Zoom parameter, fading out via the Opacity parameter, or 
cropping from one side to reveal a clip underneath via the Cropping parameters. Additionally, if you 
import a project from an NLE that has keyframed sizing settings, those keyframes will be imported 
and exposed within Resolve.

The primary controls for keyframing are within the Inspector. Any parameter that can be keyframed 
has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, this button 
turns orange and small navigation arrows appear to its right and left, otherwise it stays gray.

Orange keyframe buttons in the Inspector show there’s a keyframe at that frame

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that clip 
displays a small button at the far right of its name bar in the Timeline. Only keyframed clips have 
this button.

The keyframe track button for a keyframed clip

Clicking this button exposes the keyframe tracks for that clip. Each group of parameters in the 
Inspector has a single keyframe track, that holds all the keyframes of all the parameters within that 
group. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor Point keyframes all appear 
within the Transform track.
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Keyframing in the Edit page works slightly differently than when using the keyframe editor in the 
Color page. If you need to do more complicated keyframing than the relatively simple controls and 
linear interpolation available in the Edit page allow, you should consider using the Sizing palette 
and Keyframe Editor on the Color page. Otherwise, here are the options available for keyframing 
in the Edit page.

Methods of keyframing parameters in the Edit page:

 > To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 
to the frame where you want to place a keyframe, and click the keyframe button next 
to the parameter of the inspector you want to animate. Once you’ve added at least one 
keyframe to a parameter, all other adjustments you make to parameters in the Inspector, 
or using the on-screen Transform/Crop controls in the Timeline Viewer add new keyframes 
automatically if the playhead is at another frame.

 > To move the playhead to the next or previous keyframe: Right-Bracket ( [ ) and Left-Bracket 
( ] ). You can also click the small left- or right-hand arrow to either side of a parameter’s 
keyframe control to jump the playhead to the next or previous keyframe.

 > To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the on-screen controls of the Timeline Viewer.

 > To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 
with a keyframe, and click the orange keyframe button in the Inspector to delete it.

 > To delete all keyframes for one parameter: Click the reset button to the right of a parameter’s 
keyframe control in the Inspector.

 > To delete all keyframes in a group of parameters in the Inspector: Click the reset button to 
the right of a parameter group’s title bar in the Inspector.

 > To disable or enable a single parameter’s keyframed effect: Click the orange dot at the left 
of a parameter’s keyframe track in the Timeline. Orange means that track’s enabled. Gray 
is disabled.

 > To disable or enable a group of parameters in the Inspector: Click the orange dot at the 
left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. 
Gray is disabled.

A keyframe track for all of the Transform group parameters


